RTU32M Series — Example 1

RTU32M Application - Creating a Smart ‘1/O Box’
Application Note
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RTU32M Hardware Overview
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RTU32M — modular hardware

Module heading will change colour if 2 module is missing, or incorrect type

The ‘No Cost HMI' — HTML page published by WorkSuite for
viewing in a web browser (Smart Phone, Tablet, PC etc)

Introduction

Brodersen have been manufacturing products for use in remote monitoring and control solutions for almost 50
years. Our customer base is global and our products are used in a diverse range of Applications that include
energy management systems, water and waste water SCADA, infrastructure monitoring, building automation and
airport management systems.

This Application note provides an overview of how 1/O points, logic, communications parameters and graphics
are setup in the RTU32M. Local/HMI access can also be provided to user data via a web browser using HTML
pages published from WorkSuite. Follow the steps described to create your own application, or use the link at
the end of the document to download the project for review/modification.

RTU32M Overview

The RTU32M modular hardware provides a flexible architecture for creation of RTU solutions. Start with a CPU
and power supply, then add I/0O modules or system modules to create you desired solution. The I/O can be
together in a single block, or distributed in a ‘segmented’ arrangement of 1/O blocks. All RTU32M modules
provide access to their status, firmware and hardware revision information and serial number. 1/0 modules
include data values, data quality and timestamps of when the last change occurred (1ms resolution).
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RTU32M Setup and Creation of an Application

The hardware components

In this example, the selection of RTU32M modules used includes;

Slot | Module Description
0 MP32A CPU (2x LAN, 1x USB, 200-900MHz)
1 PS24A Power Supply (10-30V DC)
2 DI20C 20ch Digital In (incl. 2x 5kHz counters)
3 AIO8A 8ch Analog In
4 DO12R 12ch Relay Out
5 AOO02A 2ch Analog Out

Creating an Application and module list in WorkSuite
Brodersen RTU32M Applications require WorkSuite version > 3.9.2. The link below downloads v3.9.2.1218.

Brodersen WorkSuite 3.9.2.1218 (~450MB).

Diestination folder :

In this example an Application named
‘RTU32M_App1’ was created using

MNarne:

RTU3ZM_Appl
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WorkSuite allows creation of the RTU I/O module list by querying the RTU for its list of modules, or if the RTU
is not present, the list can be created by adding/moving/deleting modules using ‘drag and drop’ from the menu.
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Auto Modaule List — uploaded from RTU

Manual Module List — using ‘drag and drop’


http://download.brodersen.com/Software/WorkSuite/BrodersenWorkSuite3.9.2.1218PackageInstaller.exe

Setup 1I/O, Create Variables, App. Download

Click on a module to change its setup

1
Each I/O module has its own configuration A Tt . = - e
page with various setup parameters. me ) E - - c C | omoumzanforston
Counter: ] o (] ] ] [ i 2 3
Debounce (ms): 0 =1[o =0 =ilE =l Fault mode:
DI Parameters DO Parameters © u = © =
Inverted: o =] a =] ]
| nvert Fa u lt M ode ot - - - - - [ Module not present in configuration
Count Debounce (nS): 0 21 g 2] o =10 (|| o I
Debounce s srke s rfasaion 1
Analogue Inputs configuration
o L 2 Range: [Disabed  +| [Disabled |
Range: nu-sv -[] 4-20mA  v| [4-20ma  ~ ‘D ) _ _
AI Parameters AO Parameters Filter: [MEdlumHR v] [MEd\umHR v] [MEdlumHR v] :KE‘E:MH‘ ssj;:oo ssj;:oo
Ra nge/ M ode Ra nge/ M ode Delta Change: 0.500 0.500 0.500 _— — — |
H H Scale Min.: 0.00 0.00 0.00
;Ilteéh icalii ::/I/I":j/MaX Scale Max.: 65535.00 65535.00 £5535.00 Feultvale: Tlssmﬁsrth = S'D?t =
|g. ange au ode 5 the value to set in case of hardware failure.
Scale Min/Max | Fault Value — E—

The ‘Module not present’ allows future module slots and reuse of similar setups

Use the tag wizard to create variables

After creating a list of modules,

S | rTU32M_DNP_App1

M & % ok @ B gl 2% Al

variables are created for each 1/O

C:\Users\PubliciDocuments\RTU32ZMIRTU32M_App1 - Brodersen RTU32 IO

(ie. not ‘exactly’ the same 1/O).

=4
pOInt USIng the -ﬁ RTU32M PS24A DRoC AlDBA DO12R
. . , . o= Symbol [Type [ Channel ] l Slot2 D19 BO(
Set Variables’ icon. EETTIT T S (Yo »
-8 Slot2_DI Input Bit 1 -
Siot2_DI2 It Bit 2
iz} SISIEZDIS I:E:IE:( 3 [¥] Declare variahles in datahase
Select/highlight each 1/0O module = Bio?. DY InputGi ¢ || Bsetoteets
E Slotz_DI5  Input Bit g
H = Slot2_DI& Input Bit B
in turn, then select the Set il = seop iz 7|
. . . = 3 Siot2 DIB  Input Bit 8 (i
Variables icon using syntax to 2 S Db B 3 ot
. . o Slot2_DIN0  Input Bit 10
identify each module and channel. e Dl hpadi 10
Slotz_DN2  Input Bit 12
I__[HS__ variables in module Slatz_DN3  Input Bit 13
. . . Slotz_DN4  Input Bit 14
Starting with the DI20C in slot 2 & Slo D15 w15
tat
Eg. Slot$(SLOT)_DI$(OFFSET). —_
[} ’ .
Then replace ‘DI’ with Al, DO and AO for modules 3-5, as shown below.
Syrmbol TType T Channel I [ st Symbol | Type | Channel I 355 Symbal [Type IE L I 1 Slo
SOt AD Anclogput - 0 [ B covansoies Slot4_DO0 Output Bit O secvartier ] SIoE_ADD  Analog Output.. 0 | B setvaraoes
SIoti_ Al Anzloglnput... 1 Slat4_DO1  Output Bit 1 Slofs_AOT  Analog Oulput., 1
Slot4_D0O2 O Ei 2
z:zg‘ﬁg 2:::22:::2:: § [¥I Declate varisbles in detahase 5,24:[}03 O:ts::ﬁl: 3 || ¥Declare variables in database ¥IDeclare variables in detobase
Slotz A4 AnalogInput... 4 [7] Setoffsets Slotd_D04  Output Bit 4 || ¥setofisets [¥] Set oftsets
Slot3_AIS Analog Input 5 Slatd_DO5  Output Bit 5
Siot3 AlE  Analoglnput . B Slatd_DOB  Cutput Bit 6
Sloti_AI7 - Analogh 7 Slotd_DO7 O Ei 7 _—
3 neloglnput Name Slos(SLOT)_AS(OFFSET) iy D::’;izﬁn s || neme SIotB(3LOT)_DOS(OFFSET) Hame Slot(SLOT)_AO$(OFFSET)

Download the initial 'I/O Box’

Application

At this point the basic I/O box Application is ready to deploy/test.

| RTU3ZM_DNP_App1

Select compile to first check the variables are all OK.

If any errors exist, the compiler warnings will describe what

& W a2 & B el

=ss I

| RTU32M_DNP_App1

TI220NDTIIZI00 DND Annd Tte——

needs to be corrected. If the project compiles OK, then go

online to download the RTU Application.

Runtime

| Time

| Project Name

| Event description

2019/04/01 09:35:35.843
2019/04/01 09:39:35.843
2019/04/07 09:39:35.643
2019/04/07 09:39:35.643
2019/04/01 09:35:35.843

The Runtime TAB at the bottom of the
WorkSuite display will show if the RTU32M
modules have been correctly detected.

3

RTU32M_APP1
RTU3ZM_APP1
RTU32M_APPT
RTU32M_APPT
FTU32M_APP1

LE2: PS24A accepted as LB2#1 (28332) [ RTUIZM_APP1]
LB2: DI20C accepted as LE2#2 (1560) [ RTUSZM_APPT ]
LB2: AlDBA accepted as LEZ#3 (9220) [ RTUIZM_APPT ]
LB2: DOT2R accepted as LB2#4 (5124) [RTUIZM_APPT ]

(10756) [ RTU

M_APPT ]
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Test the Application, add Module Status Info.

View I/O values from the module editor and/or variables list

The status/values of the I/O
variables can be viewed online in
both the I/O Editor window and
the Variables List as shown here.

Slots_AOD =]

Force ]

Lock

Unlock

Double click on one of the
Output variables to change its
state/value.

2 | RTU32M_DNP_App1

M W G B g

%= 1 RUN

e B UE D

@@ [CWsers\PubliciDocuments\IRTU32MBIRTU32M_App1 - Brodersen RTU32 IO

Additional variables for power supply status

After proving the basic I/O functionality works as
expected, take WorkSuite offline and add variables to
show the status of the power supply module. Select the
power supply module, then right click in the symbol area

and select ‘Insert/Set Variable’.

Double-click in the ‘Type’ field to select the various power
supply status values and give each variable a name and
select BOOL for status and WORD for analog values. The
list below shows example power supply variables.

Symbal
Slotl _PS_BusVoltageEnabled
Slot1 _PS_Oweroadarning
Slot1_P5_OwerloadAlarm

Slotl _P3_Vaoltsin Input voltage
Slot1_PS_VaoltsOut Cutput Voltage
Slot1_PS_CurrentOut Output Currert
Slotl_P5_Load Load

hannel

Current Overload WWarning
Current Overload Alarm

Monitoring I/O Module Status and Version Information

The RTU32M I/O modules allow access to their status and version information. Data includes;

Module Type

Serial Number — High Bytes

Operating Mode

Serial Number — Low Bytes

Heartbeat Count

Internal Temperature

Message Count

Power On Counter

Hardware Revision

Watchdog Counter

Firmware Revision

Up Time Since Restart

Supply Voltage

Total Uptime Hours

PR=TED 2147 [ MName [value [Type
3 " s B AsA Sl D13 TRUE  BOOL
RTU3ZM PS24A Dizoc AlDgA DO12R  AOO2A n AO024 S\DYZ_D\‘M BOOL
A oned Slot2_ D6 TRUE  BOOL
B Dizoa L Slot2_DI16 BOOL
B Dizog 3 Slot2_DI17 BOOL
= B Dizoc Slot2_DI18 BOOL
f B DMzoa Slot2_DI9 BOOL
g B Omz0c B Slotd_AI0 696289 REAL
§ Doose Slot3_ A1 332665  REAL
H f Dolze Slot3_ A2 157978 REAL
H B DO20A Slot3_AI3 65534 REAL
Slot3_A4 0 REAL
[4] DO12R (12 Relay Outpu E :81:‘; S\DYS:A\S 0 REAL
. H Fl oo - Slot3 A6 0 REAL
Marme | value Syrbol | Type | Channel | Slot3_AI7 0 REAL
Ao DO1ZR n Sled DOO TRUE  BOOL
Description 12 Relay Qutputs Slot4_DO1 BoOL
. Slatd_DO2 BOOL
Slatd_AIN=GIE2BI  Analog Inputval . D Slet4_DOJ BooL
Slati_AI=332865  Analog Inputval 1 Slot4 DO4 BooL
Sloti_Al2=1579768  Analog Inputval.. 2 Slot4_DOS BOOL
Sloti_Al3=65534 Analog InputVal... 3 Slot4_DO6  TRUE BOOL
Slot3_Al4=0 Analog Inputval.. 4 L Slota_DO7 BOOL
Sloti_Al5=0 Analog InputVal.. 5 Slot4_DO8 BOOL
Slot_AlB=0 Analog InputVal.. 6 i Slot4_DO9 BOOL
Slati_Al7=0 Analog Inputval... 7 Slot4_DO10 BOOL
. Siotd_DOT BOOL
Slod_DO0=TRUE  Output Bit 0 RlUw (ol 12345 REAL
x Slots_AOT 0 REAL
< i : B DETAIN cmvinhine
4
CiUsers\Public\Documents\RTU32MI\RTU32M_App1 - Brodersen RTU32 10
e 4 (Al
H 2 : ¢ s A Aoea
Dizoc AlEA DO12R AO0ZA n AO02A
B oizH
2| B oizoa
B D208
i B oizoc
= B DMzoa
g B DMzoc
q B Doosr
o A porzR
B Doz0a
i) P524A; B 10144
SRR b B 1o14e
=
Hame | Walue Symbal | Type | Channel |
O | anto PE244, ’” "
EA | Description  Power Supply & Undo
@
Slot1_PS_BusVoltageEnabled BOOL |
f Slot1_PS_CwerloadWarning BOOL
1] Slot1_PS_OverloadAlarm BOOL -
1] Slot1_PS_Voltsin WORD Cr
1] Slot1_PS_VoltsOut WORD
1] Slot1_PS_CurrentOut WORD
1] Slot1_PS_Load WORD i InsenySet Varisble )
] I RETAIM variables | 8
[} Main
4| I




Accessing and Storing 1/O Module Status Info.
Creating a Structured Tag Array

A 'structured tag’ is the easiest way to view 2 | Ao et W % ijlg IR Tl
i i C:Users\Public\Documents\RTU32MIRTU32M_ TRUCT =
and store the I/0 module st‘::\tus |n.for.mat|on. o — tod zipe - sTING(25) G
To create a structured tag, right click in the “F ﬁ;g:‘e_mfo — MCA Temp : UDINT ;
variables list and select ‘Structures’, or select = Op Mod UDINT g e
It ’ . i Mod_Temp LUDINT 55§7Nn : STRING (255) :
Types>Structures’ from the main program . HwD UDINT Pur On : UDINT :
. Up Time : UDINT
tree. The example structure here is named = o P ;ﬁzgusrm;]a;r{gnmr ;
. . . 4 n H H
‘Module_Info’ and includes various unsigned mf  PurOn UDINT END_STRUCT
Up_Time UDINT
integer and string variables. Tot_UpTime UDINT ™ ’
Rx_Cnt UDINT K < » ¥ | |EC
Create a variable named ‘RTU32M_Module_Status’, with a type of [J¥[Hame [ Tyne [ Dirr. |

RTU32M_Module Status Module_Info [0..5]

Module_Info. Create an array by giving the tag a dimension of 6.

Project settings '
To use structured tags and arrays the WorkSuite project settings - Sl Pommens RTUSH RT3
must be set to include ‘Complex Variables in a Separate Segment’. S 8 Conmncssor pa s AT
. . . . ebuggin W Cydetime 1]
While making this change, also include ‘Allocate status flags for et} & Co

arate sagment_[Yes

Disabled

variables with embedded symbols’ and ‘Embed symbols of all

Ty Wersion 4-2018/0
variables’ (status flags are required to support manipulating of 3 Liorariss Eoit

3 Use external ohjects Ed!t..
DNP point status bits and embedding of symbols allows B Coda Chackar nias Ed.
referencing of variables by their tag name in HTML pages). £ Excran e whils sepping e e

ST program to Access Module Info.

Right click the Programs folder and select ‘Insert New Program’ and create
a ST program named ‘RTU32M_IO_Status’. Open the program and right
click in the variables area and create three local variables as shown here.

rl Frograms
[ hdain
7 RTU32M_I0_Status

| Type

. . . Inst_LB2_INFO LB2_INFO
Create code as shown below, compile and download the application. Serllo Sir STRING(255)
Check the logic reads the 10 module information and updates the array. ‘ Ll
EL | RTuz2M_one_spp1 & % Gk O B ge| o E[AIRUN O - ]
@8 8s [C:Users\Public\DocumentsIRTU32MIRTU32M_App1 - Brodersen RTU3210 ]
- 1// Monitor RTU I/C modules in slots 2-5 = YlName || Type | Dim_ |
" 2 /f R R K
?i . RTU32M_Module_Status Module_Info [0..5]
SFOR i := 2 TC 5 DC // loop through the I0 modules by slot number
& Inst_LB2_INFC(i): <l i
7 SerNo Str := HTORA(ANY_TO_DINT (Inst_LB2Z_ INF0.5ID2)) + ':'; // Extract the serial number ame |\/a‘ue
SerNo_Str := SerNo_Str + HTOR(ANY_TO_DINT (Inst_LB2_INFO.SID1)): 4 RTU3ZM_Module_Stas(2]
b11 ] RTU32M Module Status[i].Cp_Mode := ENY TC_UDINT (Inst_LB2_ INFC.CE): Mod }ype - e,
10 RTU32M Module Status[i].Mod Temp := ANY TC_UDINT (Inst_LE2_INFO.IntC); =
11 RTU32M Module Status[i].HW ID ZNY TC UDINT (Inst LBZ INFC.HWPID); Op_Mode 5
12 RTU32M Module Status([i].SW ANY_TO UDINT (Inst_LB2_INFO.SWPIL): Mod_Temp 41
13 RIU32M Module Status[i]. SexNo_Str; - ,L HW_ID 92980
14 RTU32M Module Status[i].Pwr | BNY TO UDINT (Inst_LB2 INFO.PwOnCnt): S0 33010
15 RTU32M Module Status[i] .Up_Time := ANY TC_UDINT (Inst_LB2_INFC.UpTim);: Ser_No AR2AEREX 21263
16 RIU32M Module_ Status[i] .Tot_UpTime := ANY TC UDINT (Inst_LB2_ INFO.TotUpTim): Puwr On 393
17 RTU32M Module Status[i].Rx Cnt := ANY TO UDINT (Inst LB2 INFC.RXCNT): Up_Time 2
18 CASE ANY TC DINT (Inst_LB2_INFO.MIYPF) OF // Show the module type as a string value Tm_UpTime 2691
19 0: RTU32M Module Status[i].Mod Type := 'N/L'; -
20 1 RIU32M Module Status[i].Mod Type := Pux_Cnt 671
21 RIU32M Module Status[i].Mod Type i= 4 RTU32M Module_Status[3]
22 RTU32M Module Status[i].Mod_Type := Mod_Type ‘AllgA!
23 RTU32M Module Status[i].Mod Type := Op_hode 5
2 RTU32M Module_Status[i].Mod Type = MDd_Temp 39
2 RIU32ZM Module Status[i].Mod Type := Hw 1D 92971
RIU32M Module Status[i].Mod Type := .5W7ID 93014
RTU32M Module Status[i].Mod Type := - f |
RTU32M Module Status[i].Mod Type := Ser_No 4B28EBE2122763
RTU32M Module Status[il.Mod Type := Puar_On ezt
RTU32ZM Module Status[i].Mod_Type = p_Time g
RTU32M Module Status[i].Mod Type := Tat_UpTime 1456
RTU32M Module Status[i].Mod Type := P _Cnt 786
RTU32M Module Status[i].Mod Type := 4 RTU32ZM_Module_Status[4]
RTU32M Module Status[i].Mod Type := .Mod_Type DoO12R
RIU32M Module Status[i].Mod Type := .Op WMode 5
RTU32M Module Status[i].Mod Type := OW .MUd_TE!mp ¥
END CASEZ: HW_ID 92584
25 END FOR; Sw_ID 93012
- il Ser '01C62247:94192954"
¥ A4 Spy lis




Create HMI Graphics to Monitor the RTU32M

Enhance the ST program logic for use in the graphics page

Create four new REAL variables to store scaled values for the power supply and four new BOOL variables to
indicate module fault status. Create code as shown here to scale the power supply values and monitor the
module operating mode.

42 // Map and scale Power Supply Info as RELLS for HMI Slot1_Supply_V 2377 REAL
43 5lotl Supply V := ( ANY TO REAL ( Slotl PS VoltsIn ) / 100.0 ) Slot1_Output 11.959 REAL
44 Slotl Output V := ('I-',:-IY:TC-_RF):-;Z { Slotl PS VoltsOut ) / 1000.0 ); Slot1_Output_mA 140 REAL
—.-: Slotl Cutput _mh = J:'a_j‘f;\_C‘_EEH_ -il_Slot,l_PS_C'.zrrentOu':', Vi SIDH_Load_F'ercent a7 REAL
:Z 5lotl_Load Percent := RNY TO REARL ( S5lotl_ PS5 _Load ): Slot2_Fail BOOL
_:5 Slot3_Fail BOOL
49 // Determine Module Cperating Status for HMI SlDM_FE?l BOOL
50 Slot2_Fail := ( RTU32M Module Status[2].0p Mode <>5 ); Slots_Fail BOOL
51 Slot3_Fail := ( RIU32M Module Status[3].0p Mode <>5 ): I RETAIN variables
52 5lot4_Fail := ( RIU32M Module Status[<4].0p_Mode <35 )
53 5lot5_Fail := ( RIU32M Module Status[5].0p Mode <>5 ) 4 LU
. . g | E3 GlatE Fail
Right click on the Watch folder and select 4 B RTU3ZM_Appl B rsert Newhem
. s 4 Exception programs
Insert New Item’, then select Watch and 4 [ Programs
: . ; Categories: Available Ttems:
Graphics. Name the new page ‘Overview1'. () Main ategories vailable Ttems
B RTU32M_I0_Status (A 63 Spy list
4 Watch (for debugging) &r&am_ B Recpe
Use the graphics editor tools to add shapes B OVERVIEWT Resources &
. . B Soft Scope Embedded HMI T Soft 5cope
and links to variables to create a Hardware BB Inifinl valuos shortas EP Test sequence
. Others
Overview as shown below. 03 Binding Configuratian
o » f Name | walue |
Idantifier E it b
. RTU32M Hardware Overview Object type 2ation
Variahle symbal
. Spying delay L
Siot 00 Siat 01 Siot 02 Siot 03 Siot 04 Siot 05 Border siza 5
MP32A PS24A DI20A AlD8 DO12R Border color | ——
Border style 3DDOWWN
o [ Data format %5
o I Background calor ]
1 R Background mode OFACILIE
1 Text 2377
2 [ Text color |
2 I = Text mode NORMAL
3
: g o0 | Fant ngme ARIAL
[ - + Font size 70
5 : Action STATIC
' s [l inimurn wvalue
e Maxirmum wvalue
. — ] | Direction CENTER
£l vir e Set gain 1.000000
7 [ Set offset 0.000000
L] 11.959 |
Y|
‘E.
o [ b Bar Graph
Loaok EEIN I Binary
1o [N b Bitmap
I Charts
gl k- Combo
b Embedded HMI (Simulation only)
Module heading will change colour if a module is missing, or incorrect type E ::EE Displays
INkKS
I Meters

Go online with the RTU to check the control actions operate correctly and that the values displayed are correct.



Published Graphics - Remote Monitoring
Export the graphics file for use with X5 Viewer or as HTML

Graphics pages created in WorkSuite can be exported for use in
the X5 Viewer Tool, or as HTML files for use by web browsers.

3 18013

Export graphic for display in the XSWiewer tool
@ Export graphic a5 HTML5 file —requires the data server on the runtime

o

Connect to the RTU — enter the User Name and Password

You are now able to connect to the RTU using you Smart
Phone, Tablet or PC.

In the example below the module in Slot 2 was removed to
show that the monitoring program created earlier is
correctly indicating a module status error.

Generate HTMLS WEE page |ﬂ|
Page Generation
Refresh rate: 1000] ms
Use Fast CGI
Download Page
/| Download Page on Target after Generation
Settings: 192.168.0.1:502 o
Driver: KSNETS.DLL Lo
Folder: www fpages/
V| Display Page after Download
Import | Cancel
Authentication Required [ﬁ,l

®

http://192 168.01 is requesting your username and password. The site says “rtu”

_—

User Names | Elalyfly

Password:  sssse

| Lancel

(i) 192.168.0.1/0VERVIEWL htm

@

RTU32M Hardware Overview
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simplifying systems

Download the example RTU32M project

Download the example project file from the Brodersen FTP server using the link below.

http://download.brodersen.com/PETER_KING/RTU32M_Appl.zip (

~67kB)

To load the demo project in to WorkSuite, first ensure you have a suitable WorkSuite version (> 3.9.2.1160)

The link below downloads WorkSuite version 3.9.2.1218.

Brodersen WorkSuite 3.9.2.1218 (~450MB).

The demo project can be loaded in to an existing
Project List, or a new Project List can be created as
shown below. Select File>New Project List. Select
an appropriate destination folder and give the
project list a name eg. ‘Demo_Apps'.

Then select File>Add Existing Project>From zip.
Browse to the downloaded zip file and select it.
You may be prompted to add items from the
projects User Library — ignore this.

Once the file is loaded you can ‘charge ahead’ and
start playing with the code and try it in your RTU
(assuming you have the same 1/0O module layout).

If you have a different module layout you will
need to edit the application.

It is recommended that you first duplicate the
project, so that you have an original copy to refer
back to, if you have difficulty making edits.

You can also edit the Project descriptions to make
referencing similar projects easy...

Note: The demo project assumes the default RTU
IP address of 192.168.0.1 is used.

Type:

File Edit View Inset Project Took Window Help
p—— —
Create a new project list lé]
Destination folder: :\Users\Public\Documents\WorkSuite Projects - E]
Mame: Demo_Apps

[E|11|:|t5-I project list

Destination folder

Name:

G UsershFublichDocumentshwiork Suite Projects

RTU32M_Appl

Brodersen WorkSuite - RTU32M_Appl

File  Edit  View

= e S A

Insert  Project  Tools  Window

Workspace
4 B RTU32M_Appl
3 Exception programs
4 Programs
[2) Main
B RTU32M_I0_Status
4 Watch (for debugging)
£ OVERVIEW!
¥ Soft Scope
EE Initial values
%73 Binding Configuration
§g Global defines
{al Variahles
4 E Types
E. BitFields

F. Enumerated Data Types

F Stuciures

(Al Projects)

Brodersen WorkSuite - Demo_Apps.w5|

Duplicate Project RTU3ZM_Appl

Duplicate as:

RTUIZM_Appla.

[ o

File Edit View Insert Project Tool Window  Help

HEEIE] A e e

Workspace
b B RTU3ZM_AppT CORIGINALY
4 2 RTU3ZM_Appla (*My Edits™)

3 Exception programs
4 Frograms
[ Main

RTU32M_I0_Status
4 YWatch (for debugging)
£ OVERVIEWT
¥ Soit Scope
B Initial values
%1} Binding Configuration
§q Global defines
(uf Variables
4 FE Types
E BitFields
E. Enumerated Data Types
E Stuctures
(Al Projects)

Additional product information is available from our website, or from the authorised distributor in your region.
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